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Introduction  

Welcome to Java Multimedia for Mobile - JM-Mobile Editor Version 1.2.5 

JM-Mobile Editor is a graphical multimedia authoring tool. It enables non-programmers 

such as designers to produce and develop complex and sophisticated multimedia presentations 

for the mobile-phones that support Java MIDP2.0. Author has a built-in graphic engine, 

allowing to easily do GUI, time and navigation scenarios edit and then to export to final 

application/document for mobile-phones. 

The figure below presents the production scheme of the JM-Mobile Editor: 

 

The multimedia presentations edited by the JM-Mobile Editor can be deployed in two 

ways: 

¶ the java Midlet applications (*.jar), that can be downloaded directly into the mobile-

phones or can be uploaded on the Web servers to distribute largely ; 

¶ the JM-Mobile Documents (a private format), that can be uploaded on the Web server, 

then can be downloaded and playback by the mobile-phones that are installed our JM-

Mobile Browser. It can be also called from another JM-Mobile Application or another 

JM-Mobile Document by the hyperlinks. The JM-Mobile Document can be also added 

into our Bluetooth Server to distribute through Bluetooth communication. 

The JM-Mobile Document deployment is more flexible than the java Midlet application 

deployment. It allows you and your clients updating easily new contents of the application. 

The java Midlet application deployment requires that your clients must reinstall the 

application each time its content is updated. 

The JM-Mobile Browser can be downloaded from our site web http://www.jm-

mobile.com. 

http://www.jm-mobile.com/
http://www.jm-mobile.com/
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The JM-Mobile supports the command line mode, type jmmobile.exe -h in the command 

line window for more detail. The command line mode is important to create an automatic 

JMM application/document exportation system. 
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Overview  

The JM-Mobile Editor relies on a multimedia presentation model that contains three 

principal dimensions: Structure, Spatial and Temporal.  

Let's take a simple example of composition of a through these dimensions, it 

should look like as following: 

  

The TextBox is composed of a Text and a Rectangle, the Text and the Rectangle have a 

region and an interval to specify WHERE and WHEN they are displayed on the screen. 

It should be noted that the integration of temporal dimension (interval) allows to evolve 

the multimedia presentations in the time, see the TextBox's presentation figure below. 

  

The presentation time of the TextBox is from 0 to 16s. During the first 2s only the 

Rectangle of the TextBox is displayed, the Text is displayed at the 2nd second and is during 

until the 14th second then the Text is disappeared. The Rectangle is also disappeared after the 

16th second. 

To help to edit easily such multimedia presentations our JM-Mobile Editor provides a 

multi-view interface as below:  
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¶ (1) is the structure view, it's the most important view that can give a view global 

through all structure of the application. Thanks to this view the authors can easily edit, 

manage, and modify their applications.   

¶ (2) is the spatial view, it displays the application and allows also to directly 

manipulate spatial location of objects.  

¶ (3) is the timeline view, it shows the time scenario of application and allows also to 

directly manipulate the presentation time of objects.  

¶ (4) is the spatial attribute view, it shows and allows to edit the spatial attributes of a 

selected object.  

¶ (5) is the temporal attribute view, it shows and allows to edit the temporal attributes of 

a selected object.  

¶ (6) is a tablepane that contents a group of the content|style|interactive attribute views.  

¶ (7) is the object palette, it presents the objects that author can drag and drop into the 

spatial view.  
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Interface  

JM-Mobile Editor provides a WYSIWYG multimedia authoring interface that allows to 

switch between editing and playing modes to see immediately editing results. Authors then 

don't have to often export their multimedia projects each time they want to see or test theirs 

editing results.  

The main interface includes: 

¶ a menu bar,  

¶ a tool bar,  

¶ a logic structure view,  

¶ a spatial layout,  

¶ a temporal organization (timeline) of multimedia project,  

¶ the attributes views and  

¶ a pallet object.  

Menu bar 

 

The title of application consists of the logo, the name of tool and then the name of editing 

multimedia project. 

File 

 

The File menu consists of: 
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¶ the New item that allows to create a new project;  
¶ the Open item that allows to open an exist project;  
¶ the Open New Frame item that allows to open an exist project in a new frame;  
¶ the Reopen item that provides a quickly opening one of the last 10 projects;  
¶ the Save item that allows to save the editing project;  
¶ the Save As item that allows to save the current project into another project;  
¶ the Store item that allows to save the current project and its resources (images, audio, video, 

etc.) into a same place, so your project will be portable.  
¶ the Export item that allows to export the current project;  
¶ the System Information item that allows to see the memory state of the system;  
¶ the Print item that isn't implemented yet;  
¶ the Close window item that allows to close a opening window;  
¶ the Close document item that allows to close a opening project;  
¶ the Exit item that allows to exit the application. 

Edit 

 

the Edit menu consists of: 

¶ the Undo item that allows to undo until 20 last modifications;  
¶ the Redo item that allows to redo a modification;  
¶ the Cut item that allows to delete an object;  
¶ the Copy item that allows to copy a object;  
¶ the Paste item that allows to paste the copied object in to a place;  
¶ the Mobile Font Setting item that allows to change/configure the mobile fonts for editing; 

Export 

the Export menu consists of the Show playback request item that allows to show a dialog 

requesting playback the exported application. 

Tools 

The Tools menu contains: 

¶ Index Generating... item allows to generate an *.ijm file (indexing jm-mobile documents file) 
from a rss file that discribes a liste of jmm documents. 

¶ Install Key License item that allows to choose to install a key license provided. 
¶ Bitmap Font Generator... item starts a bitmap font generator tool, that allows to create the 

bitmap fonts and to integrate them into the editor for using. 
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Help 
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Tool bar 

 

Control Group 

Play 

This button allows to switch to playback mode to test/see the editing results 

Pause 

This button allows to pause to edit at any moment of the project. 

Stop 

This button allows to stop and unmap all objects from screen, it then sets the project ready 

to play from begining.  

Export Group 

Export to Midlet Application 

This button starts the process exporting the editing project into a Java Midlet Application. 

Export to *.jmm document 

This button starts the process exporting the editing project into a *.jmm document. 
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Structure View 

The structure view shows the structure of the editing multimedia project. It allows 

therefore user to easily manage the editing project. It's structure view is the most important 

view of the system. Thanks to this view author can navigate and directly access to any 

element of the project structure to see, to edit or to modify it. 

 

Timeline synchronized button group  

This group of three buttons allows to synchronize each selection on this structure view 

with the presentation of the timeline view. Three buttons accord with three synchronization 

levels: 

¶ if the button is selected, the timeline view shows only the timeline element according to 
the selected object in the structure view.  

¶ if the button is selected, the timeline view shows the timeline scenario of the Scene 
containing the selected object in the structure view.  

¶ if the button is selected, the timeline view shows the timeline scenario of whole project.  

Context menu 
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Author can move the mouse pointer over an element of the structure view and click on the 

mouse right button to access to a context menu according to this element of the structure as 

following: 

 

Addition group items 

This menu item group can guide author to create a new element and then insert it as child, 

after or before of the context element in a coherence manner according to the project 

structure.  

Import PowerPoint presentation 

This menu item allows to convert a powerpoint presentation to a list of static images, then 

integrates this list of images into the project.   

Modification group items 

This edition item group allows to copy, paste or delete an element of the structure.   

Rename item 

This menu item allows to rename the element of context menu.  

Play item 

This item allows to start playing the project at the beginning of the element of the context 

menu.      
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Spatial Layout View 

The spatial layout view allows author to organize the spatial layout of project in a 2.5D 

space (x, y and z-index). It is also the presentation screen of the project when author change to 

the playing mode. 

 

Object Region and Container 

The JM-Mobile uses a spatial hierarchical layout, where the container can contain the 

others containers and the object regions.  

An object region is a rectangle where a visible object such as a text, an image, a rectangle 

or a video is displayed.  

A container allows grouping a set of containers and/or object regions. In addition, the 

flow container allows aligning its components in the vertical or in the horizontal direction.  

When you insert a visible object, an object region is created automatically for that visible 

object.  

When you insert a composite element such as a scene, a menu, a button, etc. a container is 

automatically created to group all components of this composite element. Some composite 

elements such as Listlayout, FlowLayoutMenu, etc. will create the flow containers.  
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Attention:  the hierarchical layout system will help to organize easily the spatial 

components, but sometime it creates the difficulties in editing. Please pay attention when you 

edit the deep hierarchal structures as like as the MenuItem, the Button, etc.  

Selection/Unselection 

You can select an object region or a container by click on it. When a object region or a 

container is selected, the visible object or the composite element corresponding with will be 

also selected on the structure view.  

You can select many object regions and/or containers by using Shift+ mouse click or 

mouse pressing dragging and releasing. When multiple object region and/or containers are 

selected, there is always one selection is red, this is the referenced selection, the alignment 

and the resize of the selected elements will use this referenced selection as the reference. You 

can change a referenced selection by using the Shift + mouse click.  

Attention! You must be sure that the selected object region and/or container must be direct 

children of a same container.  

You can unselect a container by double click on this container or select another 

container/object region. To unselect an object region you can select another container/object 

region, or click mouse right button then choose the ñunselect allò item on the context popup 

menu.  

Rules 

There are a horizontal and a vertical rules that allows author to manipulate the regions 

more easily. Authors can change the scales of these rule by using the button on the left-top 

corner of the view. 

Spatial layout toolbar  

Multi -region alignment : 

¶ the button allows to align all selected region by the left side. 

¶ the button allows to align all selected region by the right side. 
¶ the button allows to align all selected region by the top side.  
¶ the button allows to align all selected region by the bottom side.  
¶ the button allows to align all selected region by the horizontal axis.   

¶ the button allows to align all selected region by the vertical axis.  

¶ the button allows to make equal the width size of all selected region.   
¶ the button allows to make equal the height size of all selected region. 

One-region alignment  

This item group allows author to align the selected region with its container : 

¶ the button allows to align the selected region with the top-left corner of its container. 

¶ the button allows to align the selected region with the bottom-left corner of its container. 

¶ the button allows to align the selected region with the top-right corner of its container. 
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¶ the button allows to align the selected region with the bottom-right corner of its 
container. 

¶ the button allows to align the selected region with the center-right corner of its container. 

¶ the button allows to align the selected region with the center-left corner of its container. 

¶ the button allows to align the selected region with the top-center corner of its container. 

¶ the button allows to align the selected region with the bottom-center corner of its 
container. 

Grid item  

This menu item allows to set visible or hide the grid on the spatial layout. 

Context menu 

Author can move the mouse pointer over a region and click on the mouse right button to 

access to a context menu according to this region as following: 

 

Adjust size item  

This menu item can allows author to fix the size of region according to the intrinsic 

dimension of its media content such as the original size of image.    

When the selected component is a container, the size and the location of the container will 

be recalculated to be the smallest rectangle bounding all its children components. 

Order  

This menu item allows to change the z-index of the region of the context.   

Play item 

This item allows to start playing the project at the beginning of the element of the context 

menu. 

Spatial Attribute View 
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When a region is selected, its spatial attributes are showed on the attribute view. That 

gives author not only a global view on spatial information of the selected object, but also the 

capacity of direct modification on these spatial attributes. 
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Timeline View 

The Timeline view provides a global graphical view of the time scenario of the project or 

a portion of the project. Author can also directly modify the time scenario of the project 

through this view. 

 

Rectangle 

Each rectangle in the view presents the time life of an object in the project. It is also called 

Timeline element:  

¶ the left side of the rectangle presents the begin time of the object;   
¶ the width of the rectangle presents the duration of the object;  
¶ the right side presents presents the end time of the object. 

 

To select a timeline element, click on the rectangle; to modify the time attributes, drag the 

mouse on the rectangle or on the left side or the right side of the rectangle. 

Attention! Author cannot make a manipulating-direct modification if the time attribute 

according to the modification is indefinite.   

Indefinite time 

¶ if this symbol presents on the left side of the rectangle, that means the Begin time of the 
object is indefinite.  

¶ if this symbol presents on the right side of the rectangle, that means the End time of the 
object is indefinite.  

¶ if the background color of the rectangle is semi-transparent , that 
means the Duration of the object is indefinite. 
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There is the dependence between the Duration attribute and the End attribute. If the 

Duration attribute is indefinite, the End attribute will also become indefinite and vice versa .  

The Begin indefinite means that the object wonôt be automatically activated in the time; it 

can be activated by a couple of event and action (StartElemAction) from another object.   

The End/Duration indefinite means that the activated object wonôt be automatically 

ended in the time; it can be ended by a couple of event and action (EndElemAction) from 

another object, or its parent is ended.   

The indefinite value is very important to make the presentation of the application being 

interactive, that means the presentation of the application could be adapted in according to the 

interaction of the user.   

To change a time attribute to indefinite or definite, author can click on the right mouse 

button then choose Begin or Duration item. Author can use the Temporal Attribute view to 

do this modification.  

Hierarchical timeline  

The timeline view allows to represent hierarchically the time scenario of project: 

¶ the rectangle in the color presents a basic timeline element. The basic timeline 
element always represents a media object such as an image, a text, a geometry, etc.  

¶ the rectangle in the color presents a composite timeline element. The composite 
timeline element always represents a temporal container/operator. There are three type of 
temporal container: parallel (par), sequence (seq) et exclusive (excl). Each type of container 
is distinguished with other by a icon in the left side of the rectangle:  

o this icon represents a parallel container (par).  

o this icon represents a sequence container (seq).  

o this icon represents an exclusive container (excl). 

Toolbar of the timeline view 

On the left side of the view is a toolbar that allows to  

¶ change scale of the temporal rule ,  
¶ align the rectangles representing timeline elements:  

o   this button sets equal the begin time of all selected timeline elements;  

o this button sets equal the time life (i.e., begin, duration and end) of all selected 
timeline elements;  

o this button sets equal the end time of all selected timeline elements;  

o this button sets equal the end time of the first selected timeline element with the 
begin time of the rest selected timeline elements. 

Temporal Attribute View 

When an object is selected, its timeline element is selected in the timeline view, in 

addition its temporal attributes are showed on the temporal attribute view. That gives author 
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not only a global view on temporal information of the selected object, but also the capacity of 

direct modification on these temporal attributes. 

 

Runtime active condition 

 

 

Each element can be specified a logic expression attribute. The logic expression 

will be evaluated at the runtime when the object is activated. If the expression is false 

the object will be ignored. 

The expression attribute can be considered as the conditional statement for the 

object or the group of objects. It provides a power way to author the sophisticated 

scenarios. You can see the Kids Math Quiz project sample embedded with the JM-

Mobile Editor to know how to use the logic expression attribute of an object. 

Conventions: 

¶ the true has the value 1 
¶ the false has the value 0 

 

 

 

so we can make a logic expression as like as following: 

(($var_1 = 3) + ($var_2 = 5) + ($var_3 = 1)) = 3 

if var_1=3, var_2=5 and var_3=1 then the expression becomes: 
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((true) + (true) + (true)) = 3 <=> ((1) + (1) + (1)) = 3 <=> 3=3 => true 

if var_3=7 then the expression becomes: 

((true) + (true) + (false)) = 3 <=> ((1) + (1) + (0)) = 3 <=> 2=3 => false 

 

1. Object Palette 

This palette is found on the top-right corner of the interface. It contents a set of types of 

object that author can integrate them into his/her project. Author can choose an object icon 

then drag it on to the spatial view and finally drop it at place where he/she want to integrate it. 

 

If author want to add an object inside an other object by using the Object Palette, he/she 

must firstly select the parent object on the spatial view, if there isn't any selected object in the 

spatial view, the new object will be inserted into the current scene. 

The set of type of object is classified into four categories: Scenes, Composites, Media and 

Events objects (see project structure for more detail). 
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Exports 

Export to Midlet Application 

When user click on the Export to Midlet Application button of the toolbar, the export 

form following will be appeared:  

 

Directory 

Author can choose a destination directory 

Application name 

Author can enter a name for application 

Version 

Author can set a version number for application 

Application icon 

Author can set a version number for application 

  

When user enters all information into the form and clicks on OK button, the export 

process will be started.  

All resources (images) used in the project will be packaged with the application into the 

jar file.  



 

JM-Mobile Editor ǳǎŜǊΩǎ ƎǳƛŘŜ ŦƻǊ ǘƘŜ ǾŜǊǎƛƻƴǎ мΦнȄΣ Wǳƭȅ нллу 

  

At the end of the process a message dialog following can be appeared: 

 

It announces to user that he/she must install the J2ME Wireless Toolkit version 2.2 or 

higher to see the generated application. 

User can choose to don't show this message next time. To show this message against, user 

can go to Export -> Show playback request menu. 

The exported application can be found at Directory/Application Name/ containing two 

files: 

¶ Application name.jad  
¶ Application name.jar 

User can then put these files to a web server to distribute the application online, or can 

directly transfer the jar file to a mobile-phone by using a USB or Bluetooth connection. 

Export to *.jmm Document 

When user clicks on the Export to *.jmm document button of the toolbar, the file 

exported specification dialog following will be appeared: 

 


